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Please maximize your browser window for ideal viewing.

In this issue, we feature a case study courtesy of Michael Reinke of Reinke Software 
Engineering in Germany. It focuses on a FirstClass site that uses the power of the FirstClass 
Rapid Application Developer (FCRAD) to create and manage a series of digital libraries.  

We're also very excited to offer an article on the upcoming FirstClass telephone user interface 
(TUI) for FirstClass 8.0 Voice Services (VS).

A new addition

We've added a "Want to learn more?" section to the newsletter. This section directs you to 
additional sources of information for concepts discussed in our newsletter articles and regular 
features. We know you will find this to be an excellent resource.

Noteworthy

Due to popular demand, and since FirstClass Online (FCOL) users aren't allowed Internet email 
access, we now allow newsletter subscribers to send any questions directly to the 
TechNewsMail conference on FCOL. 

Reminders

If you're reading this on our web site and wondering why your subscription didn't arrive (or if 
you know of someone who subscribed but isn't getting the newsletter), this is likely because 
the SMTP mail rules, which you may have enabled on your site, are set to reject bulk mail. To 
prevent this from happening in the future, we suggest that you add the 
"technewsletter@firstclass.com" address to your trusted filter document inside the Filters 
folder. For past newsletters, see the archives section of our company web site.

We would also like to take this time to reinforce that the conduit for answering technical 
questions is through the FirstClass Customer Support department support@firstclass.com. 
Please submit all support-related inquiries to this area, as they will be immediately viewed by 
our support technicians and answered accordingly.

Enjoy this issue.

Editors

Ann Schwartz
Annette Ferron
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Case study: Digital libraries for medical professionals
courtesy of Michael Reinke, RSWE, Germany

Michael Reinke, founder of Reinke Software Engineering (RSWE), recently brought to our 
attention Kinderumwelt gGmbH, a FirstClass site that uses the FC MEMEX RAD application to 
create and manage a series of digital libraries. Here is their story.

The environment

Kinderumwelt gGmbH is a non-profit company with limited liability, fully owned by the German 
Academy of Pediatrics. It runs a large FirstClass site that provides services for German medical 
professionals and public health departments. The system, named UMINFO (see 
www.uminfo.de), hosts several specialized groups on a single FirstClass server.

This is the UMINFO website:

UMINFO website



This site includes the following major areas:

Uminfo/Allinfo offers environmental health information through conferences. It is used by 
medical doctors, pharmacists, engineers, scientists, and medical insurance organizations. 

ÖGD Intranet, supported by the famous Robert-Koch Institute (RKI), Berlin, is targeted to 
members of the German public health departments and offers specialized information in this 
area.

Pädinform is an intranet for pediatricians. This section offers a large collection of FirstClass 
conferences that provide pediatric information and allow different types of communication, 
including telecommunications.

Today, UMINFO is used by approximately 4000 professionals.

The challenge

Recently, Kinderumwelt gGmbH decided to expand its services by adding advanced digital 
libraries and more knowledge management functions not currently available in the FirstClass 
product. In order to achieve medical breakthroughs, UMINFO’s users must be aware of others' 
projects and publications and have full access to published papers, PowerPoint presentations, 
journals, and digital images. These documents exist mainly as attachments to conference 
messages or as documents inside the file systems of dedicated file servers.

Dr. Otto, administrator of the UMINFO system, summarized the required functionality in the 
following three areas:



• Pädinform users must be able to access single issues out of a digital archive of "Kinder- und 
Jugendarzt" magazines. These periodicals are stored as PDF files and should be fully text 
indexed for speedy retrieval. Advanced search algorithms should also be supported to narrow 
the search criteria. 

• Many conferences exist within the pädinform intranet. These conferences contain many 
messages with attachments that provide useful information (for example, PDF, Powerpoint, 
and JPEG files containing valuable EXIF metainformation). Pädinform users must be able to 
search and retrieve information from these conferences, including attachments, by the same 
methods used in the periodical digital archive.

• The same requirements exist for a third application area: the Robert Koch Institute supports 
a special conference about bioterrorism called IBBS. Inside this conference and all of its 
subconferences, many documents are available only as attachments to FirstClass messages. 
Users of the IBBS conferences must have a straightforward full text search and retrieval 
system for these attachments.

A short system analysis of the above requirements resulted in the following list of functions 
that needed to be added to the existing FirstClass system:

• full text search and retrieval of text and multimedia documents outside the FirstClass network 
store

• full text search and retrieval of documents attached to conference messages

• fast and accurate search results

• advanced search capabilities like boolean, phrase, and property search

• minimal administration overhead

• an intelligible search user interface 

• seamless integration with FirstClass, because all users already know how to use a FirstClass 
client.

The solution

FC MEMEX: An off-the-shelf FirstClass extension

FC MEMEX is an example of the robust features a FirstClass Rapid Application Developer (RAD) 
application can add to an existing FirstClass site. In this case, a combination of RAD 
applications and Windows-specific services supports the integration of multiple Windows PCs as 
document search and retrieval servers. To FirstClass administrators and users this system 
looks like one large digital library.

Let's review the major features required for the UMINFO system:

• fast document search and retrieval 

Searching a digital library consisting of thousands of mixed media files must be done in 
fractions of a second.

• fully automatic operation

• support of standard file formats with the ability to be expanded to support other formats

• ability to search within existing documents that reside on file servers.

Getting documents into the libraries

After installing the FC MEMEX application on the FirstClass server, Dr. Otto was ready to 
configure the first digital library inside the UMINFO system: the "Kinder- und Jugendarzt" 
periodical library.



In this case, all documents (a collection of PDF files) had already been copied to a dedicated FC 
MEMEX document server (a Windows 2000 workstation attached to the FirstClass server by a 
LAN), so the setup consisted of the following tasks:

1 Define a new library (called a catalog) inside the FC MEMEX management console. 

2 Configure the library’s root directory.

Below this directory all file changes are observed by FC MEMEX.

3 Configure default new user rights. 

Visiting users are added to the FC MEMEX user database automatically using this default set.

4 Define catalog-specific help text. 

This text is displayed inside the search form to all visiting users and provides helpful 
information about how to search the catalog and what kinds of documents can be retrieved.

5 Install the associated FC MEMEX search application inside selected conferences. 

This is done through the standard RAD application installation procedure with a couple of 
mouse clicks.

That’s it. FC MEMEX scans all documents inside this catalog, extracts full text and metadata, 
and updates a central index database. Now this catalog is ready for any search and retrieval 
operation.

A second way to add and organize documents inside the digital library is by using the provided 
FC MEMEX catalog browser. This application offers Windows Explorer-like remote access to the 
catalog server’s file system and allows the addition of new documents using drag and drop 
onto the browser window. This tool also allows the deletion and creation of files and folders. 

This is an FC MEMEX browser showing the PDF magazine catalog organized in annual folders:

FC MEMEX browser

Another way to get documents into a FirstClass MEMEX catalog is by monitoring existing 
FirstClass conferences with the archiving gateway FC ARCHIVE. The UMINFO team used this 
tool to set up the PaedArchiv catalog. The workflow used to populate this catalog was very 
simple:



1 Configure FC ARCHIVE to connect to the preselected conferences twice daily. 

FC ARCHIVE runs on a dedicated FC MEMEX document server and connects to the remote 
FirstClass server using TCP/IP.

2 Move all conference content to an FC MEMEX observed catalog folder.

Body texts and all attachments are preserved and immediately fully text indexed.

3 Install a second FC MEMEX search application (PaedArchiv) in selected conferences for use 
by the medical professionals. 

Through this search application all data fetched using FC ARCHIVE is available to PeadArchiv 
users.

How medical professionals use FC MEMEX

The following images show a conference with the two above mentioned search applications. 
Some help documents and an FC MEMEX reference card are available for new users in the 
lower pane of the conference, while the upper pane contains the customized RAD application 
icons. Since users were already familiar with FirstClass conferences and mail objects, and 
launching an FC MEMEX search application is like opening a conference, the system was 
adopted quickly.

New FC MEMEX users find the second tab inside the search application especially helpful. The 
“Suchtemplates” form presents a list of predefined search queries in a domain-specific 
language that is understandable to all participants. After selecting a search template and 
pressing the search button, a search process is triggered and launched against the actual (and 
possibly updated) library content.

This is the UMINFO library conference:

UMINFO conference

If a user clicks Archiv:Kinder- und Jugendarzt, they are presented with the customized, 
catalog-specific interface to the "Kinder- und Jugendarzt" library. The user can then input a 
free text query and execute a search. 

The advantage of this method is that highly complicated queries can be defined by search 
professionals and presented to all participants in a clear and easy-to-understand language.

 Note
This concept is very similar to the new "smart folders" concept that will be introduced by Mac 



OS X Tiger (coming next year), but FirstClass offered this feature first with FC MEMEX -- and in 
a real client/server environment.

This is a standard search form with a single free text query input field on which Dr. Otto 
modified the leading text "Archiv: Kinder- und Jugendarzt" and the help text in the middle of 
the form using the FC MEMEX catalog editor:

Search form

This is a search templates form presenting a list of predefined queries in a domain-specific 
language:

Search templates form



A search produces a result list. The above form produced a ranked list of documents with the 
following options and information:

• a document-specific icon 

• file name and date of last change

• automatically generated abstract text 

This is extracted from all FC MEMEX supported document types (nearly every format, for 
example, Microsoft Office documents, Adobe Acrobat PDF, XML, TXT).

• the ranking value (1-1000) and optionally, the number of direct query term hits

• a selection of possible commands:

- document preview
- document download
- document annotations

This is an FC MEMEX search result page:

Search results



In addition to the information provided in the search result list, FC MEMEX adds another layer 
of preview information. A document property form allows the user to extract as much 
information from the the selected document as possible, for example:

• a more detailed text summary retrieved directly from the document 

The length of this summary can be modified on the user preference form. Users can decide if 
this is the document they are looking for before downloading a potentially large document.

• automatically generated thumbnails of any image documents (JPG, PNG, GIF, TIFF, etc.)

• document attributes (metainformation) such as author, file size, date of last change, title, 
keywords, comments, subject, etc. (all properties that are editable within the Microsoft Office 
properties dialogs, as these properties are also searchable)

• EXIF metainformation, if it exists, for image documents 

This allows queries like: “give me all images made with a digital CANON Ixus camera”.

• document rating 

A user can rate this preview document or see all ratings already done. 

• document-related commands: 



- download original file 

This starts the FirstClass download process.

- open the document annotation form

You can enter or retrieve annotations and links to other references belonging to this document.

- open the document notification form. 

This form lists events that occur with the document, such as annotations and downloads.

 Note
Notice that to this point no download action has been triggered; all information about any 
document in nearly any file format has been presented in a secure way through the FirstClass 
client. Not a single byte of information has been saved on the local hard disk.

This is an FC MEMEX document preview of a PDF document:

MEMEX preview



The form tabs lead to different preview sections:

• "Voransicht" displays the automatically retrieved text from the original document. 

• "Dokumentattribute" displays a form with many file-specific properties. 

• "Bewertungen" displays the rating of this document. 

End result

Several hundred medical professionals are now using this digital library. The system enables 
users to easily find periodical articles or similar information using a broad range of search 
capabilities. Attachment files and content outside the FirstClass network store are no longer 



"black boxes" of hidden information. These items are now within reach of any FirstClass client, 
which was one of the most important UMINFO digital library requirements.

Administration overhead to keep the digital libraries running has been very low. Dr. Otto 
pointed out that most FC MEMEX administrative tasks were completed right after publishing the 
search applications inside the selected conferences. All new catalog users receive their default 
permission set automatically the first time they search these catalogs. All document changes 
(for example, the addition of new files into the catalog file system), are monitored by FC 
MEMEX and the text index database is updated without manual intervention.

The UMINFO team's experience with FC MEMEX has encouraged them to broaden their services 
to other areas. Dr. Otto started the creation of additional digital libraries inside the UMINFO 
system very soon after the initial periodical library. Now members of the Robert Koch Institut 
(RKI) bioterrorism conference can search and retrieve every attached document (mostly PDF 
and PowerPoint files) published in this area. 

In comparison to other available digital library applications (for example, the complete range of 
Microsoft servers like Sharepoint Portal Server), the advantages of using the RAD-based FC 
MEMEX with FirstClass are:

• no "rip and replace" solution 

FirstClass is still fully operable and does not require any replacement software. This is very 
important because the investment to get the new functionality is only focused on the new 
features.

• no client changes 

All FC MEMEX applications running on the UMINFO system are accessible with the FirstClass 
client. Most of the 4000 users use the FirstClass client, so no effort is wasted to set up an 
application-specific client infrastructure.

• scalability of FC MEMEX digital libraries is very compelling 

It's like building libraries with LEGO blocks: new document servers can easily be attached to a 
FirstClass server as needed. If future library requirements force more search-and-retrieval 
power, new document servers can be added anytime. Theoretically, a cluster consisting of 
hundreds of document servers can work inside a single FC MEMEX system.

• compatibility to common document formats covers most library applications

FC MEMEX is compatible with many file formats (.doc, .wri, .rtf, .xls, .txt, .html, .xml, .vsd, 
.pdf, .mp3, .jpg, .tif, .png, and so on). New file formats can be added using plugin architecture.

• query language is very powerful. 

FC MEMEX supports a complete range of searches, from simple text searches to advanced 
property searches and metasearches. New users get instant results, just like doing a search 
using the well-known Google service. More advanced users can step ahead and use highly 
advanced query definitions. 

After several months of working with the FC MEMEX system, Dr. Otto concluded, "The 
introduction of FC MEMEX brought a great added value to our UMINFO system. It extends the 
FirstClass base functionality with very compelling digital library and knowledge management 
functions without the need to increase the administration staff".

Finally, the integration of the FC MEMEX application underlines the suitability of FirstClass as a 
powerful and extendable communications platform. 

Contents

FirstClass 8.0 Voice Services



courtesy of the Information Development department

With the Voice Services release for FirstClass 8.0, we are expanding the scope of unified 
communications to much more than just voicemail messages in your Mailbox.

The FirstClass telephone user interface (TUI), which is at the core of the upcoming FirstClass 
8.0 VS release, gives users access to more FirstClass features than ever before:

• Desktop access: your Desktop summary is read to you at login, and gives you access to your 
Mailbox, calendar, memos, and contacts. 

• Async events: you hear your regular FirstClass sounds when logged in by phone. The familiar 
"ping" for messages and the calendar event sound alert you to new items immediately.

• Call user: instead of looking up a user's phone number and then calling, simply right-click 
(Windows) or click and hold (Mac OS) the user's name and choose "Call User" from the 
shortcut menu.

These new features are part of a continuing effort to enhance the FirstClass Unified 
Communications experience. This release is a response to customer requests for a 
cost-efficient communications solution that does not require a strictly phone-based 
environment (for example, a school where teachers and students do not have phones).

How is FirstClass 8.0 VS better?

Adding access to your calendar, contacts, and memos folders adds value to the product you're 
buying. Instead of being a limited Unified Communications system that just links your phone to 
your Mailbox, FirstClass is a true unified system that gives you easier access to more of your 
FirstClass content. The new FirstClass TUI is conceptually a Voice PDA that never needs to be 
synchronized, and is accessible from any touchtone phone. The ability to create memos also 
makes it a personal recorder. The call user functionality turns your contact database into an 
autodialer from the phone, the client, or the web, and voice menus continue to add depth to 
incoming call handling.

Do we have to give a phone to everyone?

The FirstClass TUI is specifically designed to work in environments where not every person has 
a telephone. The issue of not having a phone-based environment is resolved when customers 
learn how to make FirstClass Unified Communications fit their needs.

Let's consider a typical school environment:

• Teachers have a teachers' lounge, not individual offices.

• The school switchboard or main receptionist is too busy to field hundreds of calls for teachers 
from parents and students.

• Setting up voicemail for every teacher is impractical, since there is probably only one phone 
in the teachers' lounge, and there wouldn't be enough time for each teacher to phone in for 
messages at lunch or between classes. 

• It is impractical for students to have voicemail accounts set up on the school's phone system. 
After all, the more voicemail accounts you have, the larger voicemail system you need.

Limiting voicemail services can make it difficult for parents and students to get in touch with 
teachers. Over the years, our customers have found that giving teachers and students online 
access to FirstClass can solve many communications challenges. Let's take a look at how the 
FirstClass TUI can be used to make communication in this environment easier.

Using phantom phone numbers

FirstClass 8.0 VS can be set up without switch integration; this means that you can run VS and 
use all its features without giving every user a phone, or even a phone number on the phone 
switch. All you need is one dedicated phone line that will reach all teachers and students. 



 Note
FirstClass 8.0 VS requires hardware, software, and user licenses that must be installed before 
beginning this process.

To set up your system:

1 In the "Voice DN" field of the User Information form, simply enter a unique number for each 
user (teachers and students). This becomes the user's virtual DN (a unique phone number that 
exists only on your system).

2 Dedicate an incoming phone line just for FirstClass. This is done on the Dedicate Ports tab of 
the Voice Services Admin form — the form help explains all the details.

3 Create a voice menu for the dedicated phone number that allows callers to dial users by 
name or number to leave a message. This same voice menu can also serve out essential 
information like school news of the day, a message from the principal, or inclement weather 
notices. Also, teachers can add their own personal voice menus to post homework assignments 
or due date schedules, or to simply allow callers to leave a message.

Messages left by callers go directly into your FirstClass Mailbox. If your personal greeting asks 
callers to include their email address in the message, you can then email the caller back. In 
this way, communication between teachers and students becomes easier and more accessible, 
all without bothering a school receptionist or switchboard operator. 

Consider the student who does not have easy access to a computer outside of school. This 
student does not need to be left out of project planning discussions and scheduling; he just 
has to log in using a phone. He can then access his personal Mailbox, calendar, memos, and 
contacts just as easily as if he were logging in from his personal laptop. Taking this even 
further, if a teacher knows a student has difficulty accessing a computer, the teacher can set 
up mail rules in a project conference so all messages posted to the conference are also routed 
directly to the student's Mailbox. This ensures that the student has access to the same project 
resources as everyone else.

Do I need to replace my existing voicemail system?

Concerns over having an existing voicemail system or an incompatible phone switch are really 
one issue — you can't or don't want to use FirstClass as your voice messaging system. 
FirstClass Unified Communications is not a voicemail system; it does more than allow you to 
access and manage your voice messages. The FirstClass TUI lets you access your calendar, 
memos, contacts, and Mailbox easily by phone. 

Because we're not used to thinking about phone communication in this way, the why and how 
of this communication can be a little cryptic at first. Let's consider some of the opportunities 
these improvements provide for teachers:

• You're late for school and are scheduled to coach your team in an important soccer 
tournament. You know you won't have time to go to the school to check the location of the first 
game. While stuck in a traffic jam, you log into your Desktop by phone, check your calendar 
for the game schedule, and then check your contacts for the assistant coach's cell phone 
number. You call and reassure her that you will be there as soon as possible — all without ever 
having to hang up and fumble with a pen and paper.

• After a successful meeting with the board superintendent, a principal is heading back to her 
school, bursting with ideas. Since she has a staff meeting booked as soon as she returns, she 
won't have time to sit down and write out her ideas while they're fresh. Before leaving the 
parking lot, she logs in using her phone, creates a new memo, and records her thoughts.

• As a dedicated special needs teacher, you have set up your preferences so that you will be 
paged when you receive an urgent voice or text message. Your pager goes off. You log in by 
phone to listen to the message, but the return number the parent left isn't being answered. 
You look up the family in your contacts folder and get all their phone numbers so you can reply 
to the parent's urgent email.

• In the parking lot, you run into the board superintendent whom you've been trying to make 
an appointment with. You want to decide on an appointment time, but you don't have access 



to your schedule. You think you might be giving an exam on the day she has suggested, but 
you have to book the appointment if at all possible. Log in by phone, access your calendar, 
enter the date, and listen to details of that day. In less than a minute you know if you are 
available and can confirm immediately.

Only one of these examples mentioned voice messaging. The FirstClass TUI can be used 
without switch integration and without replacing your existing voice messaging system. It 
allows you to unify your communications and it makes communicating easier.

The FirstClass TUI in FirstClass 8.0 Voice Services is the latest in our continuing efforts to make 
communications more accessible and relevant for everyone. It can be used effectively in an 
education environment to better connect teachers, students, and parents.

A future newsletter will detail the technical aspects of new FirstClass 8.0 VS features, as well as 
how to configure VS without switch integration.
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Bookmarking your favorite web sites

Audience: All users

Experience:  

Features we use: 

• bookmarks

Summary

Do you find yourself wracking your brain for that great web site you found last week, but 
forgot to add to your Favorites list? Did you have to reformat your computer and now you've 
lost your Internet Favorites? Use FirstClass bookmarks to mark your favorite sites. You'll never 
lose them again.

Example

John Smith is a teacher at Avalon Academy. He is always searching the web for new 
information. When he finds a site he likes, he bookmarks it in FirstClass. 

To create a bookmark, John chooses File > New > New Bookmark, then enters the full path to 
the object at "URL" on the Advanced tab. If needed, he also assigns a name to the bookmark 
entry by editing the name field.

Shortcut

John can also drag the website's address icon to the URL field or directly into the Bookmarks 
folder on his Desktop.

To access the web site later, John simply goes into his Bookmarks folder and double-clicks the 
link. He can rename the link for easy reference by either clicking the name to make it editable, 
or by opening the shortcut menu from the link and choosing Rename.

This is what John's Bookmarks folder looks like:

Bookmarks
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 When I look at my web page, I see default toolbars at the left and top. Can I 
remove them?

 Yes. The process involves little more than creating a new Personal Web Page:

1 Open your Home Page Folder (called My Web Site in FirstClass 8.0).

2 Select File > New > New Document Special > Personal Web Page. This will create a new file 
called Personal Web Page.

3 Copy and paste your home page information into the new Personal Web Page.

4 Delete the old page.

5 Rename the Personal Web Page as Home Page. 

When you reload your webpage, you should no longer see the default toolbars.

Contents

 Why is the POP3 client indicator light on my Internet Monitor amber?

 None of your users have set up their POP3 import accounts. As a result, there are no POP3 

import accounts configured on your server to monitor.
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 My users often receive mail labeled as "Junk". I would like this mail to be 
labeled "Bulk" instead. How can I do this?

 In the rules.MailRules file, replace the line 

:IF ($MedSpamMax < $spamlevel) SPAM 
#The SPAM action sets $Priority = "JUNK" and $MachineGenerated = 1...

with

:IF ($MedSpamMax < $spamlevel) SET $Priority = "BULK" and $MachineGenerated = 1

Once you make this change, flush the HTTP cache on the Control tab of the Internet Monitor 
form in the Internet Services folder, then click Reload Config. 
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A look at unpublished conferences

With FirstClass 8.0, you can give users the "Publish Directory names" privilege. This privilege 
works in conjunction with the Create conferences and Create calendars privileges. If this is not 
enabled for a user, conferences and calendars created by the user will not be listed in the 
Directory, including the admin Directory. This provides an advantage over unlisted 
conferences, which can be seen by the administrator and users with the "View unlisted" 
privilege. If a user has both the "Create conferences" and "Publish Directory names" privileges, 
any conference that the user creates will appear in the Directory. Unpublished conferences are 
useful for administrators who do not want to restrict users from creating conferences, but at 
the same time do not want large numbers of user-created conferences cluttering up the 
Directory.

Because they never appear in the Directory, unpublished conferences provide an added level of 
security. Only subscribers to the conference are able to post to it, by creating a new message 
directly from the conference window. No other mail can be received, either locally or over the 
Internet.

How can these features be put to use? The exclusive nature of an unpublished conference, 
combined with its storage capabilities, allows for the creation of shared workspaces within 
smaller, private groups. Similar to the My Shared Documents folder on the Windows desktop, 
users can send files to the conference to share with other users, and access files that other 
users have sent. Unlike the My Shared Documents folder, users don't have to worry about 
unwanted input from unwelcome users registered on the same server. Shared knowledge 
repositories are also possible with unpublished conferences, perfect for small learning 
environments such as the classroom.

An added benefit to unpublished conferences is that the conference name doesn't have to be 
unique. Since none of the conferences show up in the Directory, you can give multiple 
conferences the same name (useful for multiple classes).

Here are some examples of unpublished conferences at work:

Example 1
A group of employees are assigned to work on a confidential company project. One of them 
creates an unpublished conference with the others as subscribers, so they can share resources, 
questions, progress reports, and completed work amongst themselves without the chance of 
others or the administrator stumbling upon the conference in the Directory.

Example 2
A high school art teacher creates an unpublished conference for her class, putting in notes 
about different painting techniques, art periods throughout history, and so on. Students in the 



class, each given an assignment on the life and works of a particular artist, post their work in 
the conference for each other to look at and study from for the final exam. The teacher has 
three different classes, so she creates a conference for each one. She names them all "Miss 
Morelli's Art Class" without worrying about duplicate names, as none of them will be in the 
Directory.
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FirstClass keyboard shortcuts

If you are a longtime FirstClass user, you are probably familiar with many of the keyboard 
shortcuts. Most of the shortcuts available are shown next to their corresponding commands in 
the menus, but others are not as obvious. Here are some convenient shortcuts that you may 
not be aware of:

Connect/Disconnect
Windows/Linux: Ctrl K
Mac OS/Mac OS X: Cmd K

Cycle through Filter views (all, incoming, unread, outgoing, and unsent items)
Windows: Insert

Delete the next word
Windows/Linux: Ctrl Delete
Mac OS/Mac OS X: Option Forward Del

Delete the previous word
Windows/Linux: Ctrl Backspace
Mac OS/Mac OS X: Option Delete

Find Previous
Windows: Shift F3
Mac OS/Mac OS X: Shift Cmd G

Find Next
Windows: F3 or Ctrl G
Linux: Ctrl G
Mac OS/Mac OS X: Cmd G

 Note 
You can use the Find Next shortcut to search through more than just documents. If you type a 
person's name (or any word or number stored in the columns) within a container or your 
Mailbox, you will jump to its first instance. Pressing F3, Ctrl G, or Cmd G will take you to each 
subsequent instance of that name. You can even continue to do this in another container.

Move between panes
Windows/Linux: Ctrl up or down arrow, Ctrl Tab, or F6
Mac OS/Mac OS X: Cmd up or down arrow

Open link in editable content
Windows: Ctrl-click
Mac OS/Mac OS X: Option-click

Scroll one screen at a time (one page at a time in presentation view)
Page Up/Page Down

Select all items with a common value
Windows/Linux: Ctrl Shift-click
Mac OS/Mac OS X: Shift Cmd-click

Stop activities



Windows/Linux: Ctrl Enter
Mac OS/Mac OS X: Cmd .

Zoom In (viewer window)
Shift up arrow

Zoom Out (viewer window)
Shift down arrow
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This section suggests documents from our help and web sites that will give you more 
information about the topics covered in this issue.

 Digital library

For more information on the FC MEMEX RAD application, visit the Reinke Software Engineering 
product web site at www.en.rswe.com/FC%20MEMEX.

 Voice Services

For more information on the current version of FirstClass Voice Services (version 7.1), read 
About Voice Services in the Voice Services online help conference and UC User Guide in the 
Client Help conference located in our online help.

 Bookmarks

For more information on FirstClass bookmarks, read the Linking to objects document in the 
Client Help conference located in our online help.

 Creating web pages

For more information on creating your own personal web pages in FirstClass, read the Sharing 
information on the web document in the Client Help conference located in our online help.

 Managing incoming mail

For more information on FirstClass mail rules, read the Using rule.MailRules document in the 
Internet Services conference located in our online help.

 FirstClass keyboard shortcuts

For more information on FirstClass keyboard shortcuts, read the FirstClass commands 
document in the Client Help conference located in our online help.

How to find information in the online help

To search FirstClass online help:

1 Choose Help > Contents.

2 Open the appropriate conference (for example, Client Help). 

3 Choose Edit > Find.

4 Type the words you want to find at "Find", select your preferred search options, then click 
Find. 

This will produce a list of documents that contain the words you specified.



Each conference contains a What's in this help table of contents. You can search these 
contents to quickly find documents that match your search criteria. Using this method also lets 
you refine your search. For example, you can just search for words that match the 
capitalization of your search words.

The About this help document is a useful source for finding information in our help system.
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Certain features mentioned here may not yet be released, and may not be currently available 
in all geographic regions. Open Text Corporation reserves the right to modify or cancel any 
features mentioned here. 

Here are some of the topics we plan to feature in upcoming issues:

• Branksome Hall Case study
Read about how this private school has used FirstClass RAD forms, conferences, and 
messaging to greatly enhance their learning environment.

• Using your Blackberry device with FirstClass
Learn how to integrate your Blackberry with FirstClass to ensure you will get your messages 
instantly, no matter where you are.

• FirstClass language resources in schools
Learn how FirstClass can be used efficiently and effectively in a multilanguage school setting.
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Share your thoughts and ideas

Do you have additional knowledge to share? New information or handy tricks to reveal? Please 
send them to us. In addition, send us questions you want answered by developers and 
technical staff, suggestions for articles and content, queries about how to perform tasks that 
may make your job easier, and general comments about our newsletter. 

Site visits

The Information Development team conducts site visits to gain feedback from administrators 
and users of FirstClass. Previous visits have proved successful, and were found to be mutually 
beneficial. If you would like to schedule a site visit at your company, send us an email 
(currently in the Greater Toronto area only*).

*If you are outside of the Greater Toronto Area, we can organize a teleconference so you can 
still take advantage of the benefits these meetings provide.

Please send all correspondence to the TechNewsMail conference 
(TechNewsMail@firstclass.com). 

Resources

Documentation

Looking for new documentation? Existing documentation? Check out Documentation on our 
web site.

On your own server, check online help for copies of the documentation that correspond to your 



server version. 

Training

The Richmond Hill office holds customized training courses throughout the year. For a training 
schedule or course descriptions, including prerequisites, see Training on our web site. If you 
have any questions, please address them to FirstClass Training or training@firstclass.com.

Archives

Previous newsletters can be found in the archives on our web site.

Subscribing or unsubscribing

We want this newsletter to reach all of the people in your organization who will directly benefit 
from it. If you would like to subscribe anybody else to this newsletter, please provide us with 
their email address or FirstClass account. Enter SUBSCRIBE as the subject line.

If you would like to unsubscribe from this newsletter, send us an email with the subject line 
UNSUBSCRIBE.

Please send all correspondence to the TechNewsMail conference 
(TechNewsMail@firstclass.com). 

Contact information

Editors: Ann Schwartz, Annette Ferron
TechNewsMail@firstclass.com (TechNewsMail conference)

www.firstclass.com
sales@firstclass.com (Sales)
support@firstclass.com (FirstClass Customer Support)

Main number: 905.762.6000
Main fax number: 905.762.6151
Toll-free number: 1.888.588.3444

Our address is:

Open Text Corporation
FirstClass Division
38 Leek Crescent
Richmond Hill, ON
Canada, L4B 4N8

Copyright notice

Information in this document is subject to change without notice. Certain features and 
products described in this document may not yet be released, and may not be currently 
available in all geographic regions.

All rights reserved. FirstClass, Centrinity, Livelink, Open Text and other trademarks and the 
associated logos used herein are trademarks of Open Text Corporation and/or its subsidiary 
used under license. All other trademarks are property of their respective owners.

This document is bound by international copyright law and the FirstClass Software License 
Agreement and Limited Warranty included with every FirstClass product.

Copyright 2004 by Open Text Corporation.

Contents




